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Safety Instructions

Please keep the display away from any heat sources. Place the display in
a stable and well-ventilated place.

Please handle with care as product contains glass.

The holes or openings on the display are designed for ventilation. Do not
cover or block the ventilation holes or openings with any objects.

Remove protective covering from the screen before you use the display.

Shut off the power supply before cleaning. Use a soft lint-free cloth
instead of a tissue to wipe the screen.

You may use a glass cleaner to clean the product as required. However,
never spray the cleaner directly onto the display surface.

Do not attempt to repair this product yourself! Improperly disassembly
of the product may invalidate the warranty and lead to possible danger

If you have a problem that cannot be solved using the "Troubleshooting"
guidelines, please contact your supplier.

Page 2



40” High Definition Digital Advertising Display User’s Manual

Quick Start Guide

This section of the guide is to allow rapid set up and use of the unit. Please refer to the main part
of the User Guide for full information on use of the unit.

Please follow the steps detailed below:

1.
2.

Unpack unit and place in desired location

Take the power lead from the accessories bag, insert the lead into screens and connect to mains
outlet. The unit will power ON automatically. You will be greeted by the start-up screen.

. Collect the files you wish to display and make sure they are supported by the unit (see Section

2.2)

. On a PC copy the files you want to play onto an empty USB drive. These should be in the root

directory (without putting them into a folder). Remove USB from PC.

. Insert USB drive into the USB port located on the on the bottom of the unit (see Figure 1).

The screen should indicate that it is copying the files onto the unit. Please note that all files
currently resident in the unit will be deleted. Once completed, the screen will display a
message to remove the USB drive.

. Remove the USB drive and the unit will play the stored files in a loop.

| S

USB Port

GCuao o

 sg4p 0,00 O

Figure 1 Position of screen inputs
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1. Introduction

Congratulations on your purchase of our product. Please read carefully and follow all instructions
in the manual before first use.

The product should not be exposed to liquids dripping or splashing and no objects filled with
liquids, such as vases, should be placed on the product.

For user convenience, a number of operations can be performed through the remote control.
Attention:
1. Do not change any default setting when it is unnecessary.

2. Keep the product far away from water during installation and use.

1.1Box Contents

1x40” Digital Advertising Display
1xMounting Plate

1xSecurity Screw

1xPower Cable

1xCD (User Manual and Software)
1xRemote Control

2xKey

1.2Product Overview

% @ Remote Control Sensor
@ Air Vent
% ® Inputs
4 Power In
% 5 Security Screw Recess

e e
B B 5

‘T | 6 Lockable Card Compartment

Figure 2 Product Overview
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1.3Remote Control

Remote instruction

Button Description

POWER

4

33
+ (volume)
- (volume)

PLAY/PAUSE

*

—

\

<
STOP

SETUP

Power on or off

previous program

Next program

Raise volume

Lower volume
Play/Pause,Confirm selection
Up,navigation button
Left,navigation button
Down,navigation button
Right,navigation button

Stop the selected file

Menu setting
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1.4Replacing the Remote Control Battery

1. Open the battery cover

2. Take out the battery box in the right direction as shown in the picture below
3. Remove the used battery

4. Insert the new battery with its terminals corresponding to the indicator

5. Put the cover back in

) N
'
=4
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1.5Menu Operation

Main Menu includes following sub-menus: Input Source, System, Display, Clock Setup, ON/OFF

Time Setup and Volume Setup.

Press “SETUP” to enter Main Menu, pressP to

selection. Choose EXIT to exit the Main Menu.

Main Menu

Input Source

System

Display

Clock Setup

ON/OFF Time Setup

Volume Setup

EXIT

Input Source:

select the right item, press “PLAY” to confirm

The default input is Storage, press ™\, to select another input source, press “PLAY” to confirm

selection.
Input Source
Storage
YPbPr
HDMI
AV
VGA
Return Main Menu
System:
System
Language: ENGLISH
Show time: OFF
Clock mode: -
Auto play system:
Seamless play: OFF
Photo time: 10 Seconds
Restore default:
Return
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> Language: & /& + 3, ENGLISH
> Clock: Turn the display clock ON/OFF, the default mode is OFF

> Clock Mode: --:--,--:--:--

> Auto Play System: Play Media, Function Mode, Time Mode

Play Media: Play programs stored in CF card automatically

Auto play system

Auto Play Configuration Play Media

Play Port Time Set
1 Storage 0:00

Start Time Port End Time
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0

Return

Function Mode: programs can be played repeatedly according to pre-setup time.

Press €= button to select item and press M to set up parameter.

Auto play system

Auto Play Configuration Function Mode

Play Port Time Set
1 Storage 0:00

Start Time Port End Time
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0
OFF 0:00 Storage 0:0

Return
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Time Mode: It will play according to programmed schedule. There are 4 time periods to set up.

> Seamless Play: The video file will play seamlessly if this function is turned ON. Factory default
mode is OFF

Note: If this function is turned ON, the file format should be the same (including AV resolution,
frame rate and other specification), otherwise there will be intervals between each file.

> Photo Time: Set image display time from 5 seconds to 60 seconds.

> Restore Default: Restore all parameters to factory mode

Display:
> Set screen Brightness, Contrast, Color (Saturation), Sharpness, Tint

DISPLAY
Brightness 50
Contrast 50
Color o9
Sharpness 50
Tint 0
Aspectratio Full
PC setting

Return main menu

> PC Setting: only applicable with VGA port

e Auto Adjust: adjusts automatically according to the input signal
e Horizontal Pos. / Vertical Pos.: adjusts the position of the image on the screen
e Clock: adjusts the clock

e Phase: adjusts the phase
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PC SETTING
Auto Adjust
Horizontal Pos. 50
Vertical Pos. 50
Clock 0
Phase 60

Return main menu

Clock Setup:

Press €&-> button to select item and press 1" setup parameter.

CLOCK SETUP

CURRENT TIME

2010 Year

12 Hour

Confirm

Return main me

Jun. Month

55 Minute

nu

Jun/14 12:55

14

Date

ON/OFF Time Setup:
It can be set to two modes: Uniform Mode, Week Mode

Uniform Mode: Set it for the whole week, for example, turn it ON at 8 am, and turn it OFF

at 10 pm.
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Factory default is ON. Press ¢&-> button to set up ON/OFF mode and press play to confirm

selection.
ON/OFF Time Setup
ON/OFF Mode Uniform Mode
Everyday
ON/OFF Mode Normally ON
Active ONTime OFF Time
Rangel OFF 0: 00 0: 00
Range 2 OFF 0: 00 0: 00
Range 3 OFF 0: 00 0: 00
Return Main Menu

Week Mode: Set it for every day within one week, for example, set it ON/OFF mode from

Mon. to Fri., and set it to always OFF at weekend.
There are three ON/OFF mode: Normally ON, Always OFF, ON/OFF setup.

Normally ON: the player keeps turned ON once power is connected.
Normally OFF: the player will turn OFF after two minutes if there is no operation.
ON/OFF Time Setup: 3 groups of ON/OFF setup provided in the menu.

Press ¢--> button to set up ON/OFF mode and press “PLAY” to confirm selection.
Note: factory default is Normally ON.

ON/OFF Time Setup
ON/OFF Mode Week mode
Friday
ON/OFF Mode ON/OFF setup
Active ON Time OFF Time
Rangel OFF 0: 00 0: 00
Range 2 OFF 0: 00 0: 00
Range 3 OFF 0: 00 0: 00
Return Main Menu
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Volume Setup:

Press “VOLUME +” or “VOLUME —“ to adjust volume or press - button to select.

VOLUME SETUP
DEFAULT VOLUME 30
Rangel OFF
Range 2 OFF
Range 3 OFF
Confirm
Return Main Menu

Press “PLAY” to set up volume of each range, press M\ to select the right item.

Return to exit. See below drawing.

Choose

VOLUME SETUP
DEFAULT VOLUME
active OFF
Rangel Start Hour 00
Range 2 Start min 00
Range 3 End Hour 00
End min 00
Volume 0
Confirm
Return Main Menu
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2. System Operation

2.1System Functions

1. Auto Copy Function: import the media file from flash disk to memory card automatically.

2. Auto Play System: users can set times to switch input signal from different ports and internal
storage.

3. Timer ON/OFF function.
4. Seamless Play: no black screen when program switching by following the below requirements:

1) All of the media files should be the same format, for example it can support suffix .TS
OR .MPG video file, not both.

2) The resolution, codec, code rate, frame rate should be the same for all video files, and the
audio coder, sample rate should be the same for all audio files.

Note: If playing high definition (HD) combine with standard definition (SD) video file, it should:

1) Use video converter (like Ulead Video Studio) to convert the SD and HD video files to be one
HD video program.

2) Use video converter (like Ulead Video Studio) to convert the resolution, codec and frame
rate of SD file to be the same as the HD video file.
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2.2Supported Media Files

Regular play
Video Codec Container
MPEG1, 2 MPG, MPEG
MPEG2 -TS
MPEG2, H.264 H264-TS
MPEG2 MPEG2 —PS
MPEG4
Xvid 1.00
Xvid 1.01, Xvid 1.02, Xvid 1.03, Xvid
1.10-betal/2
H.264 AVI, MP4
H.264, MPEG], 2, 4 MKV
Seamless play
Video Codec Container
MPEG1, 2 MPG, MPEG
MPEG2 -TS
MPEG2, H.264 H264-TS
Audio Codec Suffix
MP3 .mp3

1. Supported video files include: MPEG2, H.264 file. This unit does NOT support DIVX6.x,
MSVC/CRAM, MP42, GMC, IV32, RLE, cvid, VC1, RV20 and WMV.

2. Supported audio file: MP3. This unit does NOT support Sony ATRAC3, DTS, Dobly HD.
3. Supported image file format is JPEG. This unit does NOT support Progressive JPEGs.

4, Support storage devices (memory card) in NTFS, FAT32 and FAT16. This unit does NOT support
NTFS compressed file.

Video and image files should be a maximum 1920x1080 resolution. (16:9 aspect ratio)
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2.3Steps to Load Media Files

1. Copy the files you want to play on to USB drive in the root directory (without putting them into a
folder).

2. Insert USB drive into the USB slot (see Figure 1 and Figure 3).
3. This will automatically delete any files currently stored on the unit’s internal memory.

4. The files will then be copied to the internal memory and once completely loaded it will ask you
to remove USB drive.

5. Remove the USB drive.

6. The unit will now play the stored files.

2.4Inputs

CF/SD — Compact Flash and Secure Digital Card Reader
HDMI — High Definition Multimedia Interface Signal Input
VGA —Video Graphics Array Signal Input

YPbPr — Component Signal Input

Video In (AV) — Composite Signal Input

(@)
©

O |

|
00
00

CF&SD Port
Y _ __Po__ P ___
I N !
O O 0O Or

VAN - Eo— ===t |

—— e ———

ACIN

Figure 3 Screen inputs

Note: The YPbPr and VGA connections cannot be used at the same time, and their audio
connection cannot be connected at the same time.
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3. Installation

3.1Wall Mounting — Landscape Orientation

1. Empty contents of the box and test the screen’s power supply before mounting.

2. Clean the wall and mark out the position of the mounting plate.

u L]
- -
L ] L ]

] | ]

Figure 4 Mark out the mounting plate

3. Mark out the plates hole positions on the wall for drilling (you can drill your own holes in
the mounting plate if required).

Figure 5 Drill holes

4. Once holes are drilled into the wall insert wall plugs and fix the plate to the wall using
additional screws.
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Figure 6 Insert wall plugs
5. Once secured to the wall, hang the display on the bracket and connect to the mains.

6. For an extra security measure open the Lockable Card Compartment (see Figure 7) and
secure the display to the wall bracket using the security screw provided.

Security
screw

Figure 7 Security screw
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3.2Wall Mounting — Portrait Orientation

1. Empty contents of the box and test the screen’s power supply before mounting.

2. Clean the wall and mark out the position of the mounting plate.

Figure 8 Mark out the mounting plate

3. Mark out the plates hole positions on the wall for drilling (you can drill your own holes in
the mounting plate if required).

Figure 9 Drill holes

4. Once holes are drilled into the wall insert wall plugs and fix the plate to the wall using
additional screws.
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Figure 10 Insert wall plugs

5. Once secured to the wall, hang the display to the bracket by locating the guide holes and
sliding right.

6. Connect screen to the mains using the power cable provided.

7. If you are displaying the screen in portrait orientation it is ESSENTIAL that you secure the
screen to the mounting plate. Do this by first opening the Lockable Card Compartment
(see Figure 11) and then fix the display to the wall bracket using the security screw
provided.

Security
screw

Figure 11 Security screw
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4. Advanced Guide

Although this unit can operate without using any additional software, for more advanced
applications please copy the scheduling software or Playlist Editor (on the CD provided) to your
computers’ hard drive. The software also allows you to edit existing

4.1 Main Menu

On opening the application you will be greeted by the main menu screen, giving you the options of
“Create New Playlist” and “Load Existing Playlist”.

4.2 Creating Playlists

Once you have selected “Create New Playlist” the playlist creator will be launched.

£, Advertising LCD Playlist Editor

Step1: Add Schedule -2 Playlist

Step2: Add ems

The Playlist Editor is laid out in a user friendly way with the primary functions on the left hand side
in easy to follow steps.
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4.2.1 Add Schedule

The schedule functions as a timer for the playlists, so you can have between one and eight
playlists scheduled to start and end at different times of the day, with up to 50 files in each
playlist.

Note: If you enter more than one schedule ensure that the consecutive schedule times do not
overlap.

Click on the “Add Schedule” Button

> Type a Schedule name

> Select preferred start time

> Select preferred end time

> Click “OK”

> Schedule will appear in the playlist.
To add more schedules simply follow the whole process again for the preferred number of
schedules, ensuring you select unique schedule names and times.

5 Advertising LCD Playlist Editor [=iEi=

Step1: Add Schedule -+ Playlist

.

il

z
N

-

Q/f

Step2: Add ftems

<'
4

&

|

4.2.2 Add Selected Items

Note: For compatible file formats please refer to 2.2 Supported Media Files.
Adding Images

Note: Before adding an image file please ensure that it has a file name of 11 characters or less
and that it is NOT a progressive JPEG, as these files will be skipped.

Click “Add Image”
> Select appropriate Schedule
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> Click “Browse” and locate and select files
> Enter a duration time

> Select Image switch mode

> Click “OK”

> Image appears in Schedule.

You can select multiple image files at once to add to a schedule, you can also move each item up
or down in the playlist by using the arrow buttons on the right hand side.

Step1: Add Schedule -+ Playlist

i@ Schedule Name:Schedule1 Start Time:08:00 End Time:20:00

Step2: Add ltems.

Adding Audio

Note: Before adding an audio file please ensure that it has a file name of 11 characters or less.

Click “Add MP3”

> Select Schedule

> Click “Browse” and select MP3 file
> Enter volume level

> Click “OK”

> MP3 Appears in Schedule.

Note: You must add audio files after all image files.

Step1: Add Schedule -+ Playlist

i@ Schedule Name:Schedule1 Start Time:08:00 End Time:20:00

Step2: Add ltems.
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Adding Video
Note: Before adding a video file please ensure that it has a file name of 11 characters or less.

Click “Add Video”

> Select Schedule

> Click “Browse” and locate Video file
> Enter preferred repeat

> Enter preferred volume

> Click “OK”

> Video appears in playlist.

Note: You cannot add Videos and MP3 audio files in the same schedule.

4.2.3 Saving

Note: Before saving please ensure location drive is empty.

Click “Save to Disk”
> Click “Browse” and select the top level of the USB drive as the location of the playlist and files
> Click “Save”.
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4.3Editing Playlists

From the main menu click “Load Existing Playlist”

> Locate and select playlist to edit

> Playlist appears in playlist creator

> Select item to edit and click “Edit” button located on the top right hand side of the application.

Note: You can also add items to the playlist and add further schedules.

4.3.1 Deleting Items

To delete items within a playlist, select the item and click “Delete” - located on the right hand side
of the application. The item will be removed from the playlist.
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5.F.A.Qs and Troubleshooting Guide

5.1How do | play PowerPoint presentations on my display?

5.1.1 Option 1 (for plain slides with no animation):

You can save the PowerPoint presentation as a JPEG File Interchange Format (.JPG). Microsoft
PowerPoint software allows the user to do this

1) Create or open a PowerPoint presentation.

2) Click File >Save As

3) Enter a File name

4) Click on “Save as type” scroll down and find the file extension “JPEG file interchange format”, as
shown in the image below.

Favorites
=
= = | . .. "
File name:  [pigital Sign | cave
My Network =
Places Save as type: |F‘resentaﬁu::n - Cancel |

Design Template |
PowerPoint Show

PowerPoint Add-In

GIF Graphics Interchange Format

5) Click Save.

6) A message will appear asking if you would like to save all slides as JPEG's

7) Once you have selected your option, The JPEG images will be saved and are ready to use within
a playlist or to upload to a storage device.

Note: For the best portrait resolution, you can use this PowerPoint Page Setup: Width 42.6cm;
Height 24cm (16:9 Ratio)

5.1.2 Options 2 (for presentations with animation):

You can convert the PowerPoint presentation to a MPEG video clip. For the best display quality
you should use the MPEG2 format which gives the best display quality. We suggest that you use
the following software:

Software Name: Wondershare PPT2DVD

Web link: http://www.ppt-to-dvd.com/ppt2dvd/overview.html :
Select Video Format: PowerPoint to MPEG2 Video Settings:
e TV Standard: NTSC (29.97fbs);

Page 27


http://www.ppt-to-dvd.com/ppt2dvd/overview.html�

40” High Definition Digital Advertising Display User’s Manual

¢ Standard: Standard DVD;
* Aspect Ratio: 16:9 (widescreen);
* Encode Size: Width 720, Height 480.

5.2Wireless connection

The screen does not have a wireless capability built in. However, with the range of screen inputs
available as shown in Figure 3 an external network media player can be easily connected.

5.3Video Conversion

There are two possible tools for converting video

5.3.1 Format Factory
This is a free multipurpose convertor that can be used for normal definition
Normal Definition

1. Download a free convertor (Windows) called Format Factory which can be found
at http://www.formatoz.com/

2. Start the Software (picture 1).

FormatFactory 2.60 - 8 X

Task Skn Llanguage Help

_ Remove ¢ Cleartist | /A . Sto l-;‘ g Option | 47 Output Folder Lﬁ\HDmEPagE
E vid |
2 SSa— Format ooc
L i Factory ==
Al to RMVE b Y i
E:_ Source Size Convert State Sutput [F2]
Alto GIF
CEYI,
[}
Al to Wiy
b
=)

All to MKY

m fay -
© ; ‘\ b
All to MPG 90 (= s,
Lo \ _rnl‘uﬂn' -

4l to VOB =

Audio

Alle]l=

. C:\Documents and Settings \Kevin Sunipy Documents\FFOutput | Eiapsed Time ; 00;00;,00 | After Converting ; Shut Down Computer. .z

3. On the left hand window pane select the ‘Video’ conversion options.
4. Select the ‘All to AVI’ conversion

5. Click the ‘Add File’ button and locate the file to be converted.
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i@ 0 “ac 4 - = xm
Task Skin La &0 b 3
Qpen ]
= } Of
= Look e | (9 181,32H1, 40H1 46 v ©F > m-
B o &117.mpg @ | Add File
HNatwark Magic Video Size | SetRange
Folders
L}
My Recent
Documents
'L E}
Desktop
My Dcumeits
E;g File niame: [ v ®
My Computer | Files of ype: | &l Supported Video Files v [ ceneal |}
] et ceTt T TV TTET Taree) Y| sddFoid |
=] i
@ ROMDI | 47 Output Falder | C:\Documents and Settingsikevin Sunibly Documents\FFOUtp v | | ioviey ‘

& C:\Documents and SettingsKevin SunMy Documents\FFOUtpUt

6. Click the ‘Output Setting’ button and modify it to look like the image shown below. A number
of important settings have been highlighted.
7. Select ‘OK’ to save these changes and then Press ‘OK’ button to goto main screen
W Video Setting x
Profile
| A1 (S
¢ |Q\HD 1280720 XVID Wide SI:reen_) V| = E | Save As | | ok
Setting Walle
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8. Press the ‘Start’ button along the top to start the conversion. Once completed, press the
‘Output Folder’ to see the converted video.

2 FormatFactory 2.60 = x

Task Skin Llanguage Help

_ Remare 5 Clearlist | Ao -- g option {42 | Qutput Folder LﬁlHnmgPage

= Video

&< Format o S
8 = = —y 4 ra, L EeE ;
© 4“\ ., - e s
alisio @ Factory ==4

mi' Source Size Convert State Qutput [F2]

B 17.mpg 24,76M All ta MPE Ci\Documents and Settingsikevin ...

All to GIF
Lt v N
6
All to WMy
-
All to MKV
rarc)
G‘.
All to MPG
[&]
All to VOB =
Audio
Picture

ROM Device\DVDICDYISO |

il | ) |~

Advanced |

2. C:\Documents and Settings!i<zvin SunMy Documents'FFOutput

i Shut Down Computer i

5.3.2 HD Video Converter Deluxe

This is only really useful for High Definition videos.
Download link: http://www.winxdvd.com/hd-video-converter-deluxe/

This software does require to be bought.

MP4 gives the best display quality. Please follow the following steps:
1. Select “to HD MP4” tab.

2. Change audio quality to 448 kbps, and change video quality to 12000, output image setting

to custom size with custom aspect ratio, and video resolution to HD1080P(1920:1080),
video codec to MPEGA4.

See the screen shot below for the recommend settings.
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5.4Connecting screen to PC

The simplest way is to use the VGA output from the PC or laptop and connect to the VGA input
(section 2.4) on the Display panel.

The display panel also has a HDMI and some PCs have HDMI output. In this case connect the PC
HDMI to the input HDMI on the Display panel.

5.5My Remote Control does not appear to be working

The remote controls have been design to have a limited range as some applications require several
screens close together and individual control of each. If you are experiencing difficulties in
operating your remote please follow these steps before calling your supplier.

1) Try pressing “SETUP” with the remote a few inches away from the unit just below the
display (see section 1.2). If this does not bring up the menu screen then go on to step 2.

2) Replace the batteries in you Remote Control (see section 1.4). If this does not solve the
problem then please contact your supplier.
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5.6 My media file does not fit properly on the screen

If your media is being displayed with black edges please refer to section 2.2. This has happened
because the file is not 16:9 aspect ratio (1920x1080). Please resize file to 1920x1080 pixels and
try loading the media onto the display once again.

5.7My media file will not display or is missing from the playlist

In this situation the first step to take to find the root of the problem is to start with a blank USB
drive. Copy 1 file onto the blank USB drive and insert this into the unit, ensuring that the file
name is 11 characters or less. If this works and the file displays then re-name all the files that are
12 characters or more to have shorter file names.

If this does not work please check first that the media file is the correct size to fit the screen
—1920x1080 pixels. If it is any bigger than this there is a danger of the media file not displaying.
For images, check that it is around 1-2 MB in size and that it is a baseline JPEG not a progressive
one — as these will be skipped. This can be checked by using free software called IrfanView.

1) Download Irfanview
from http://download.cnet.com/IrfanView/3000-2192 4-10021962.htm!?part=dl-IrfanView
&subj=d|&tag=button

2) Launch the software then open image file within the program.

3) In the toolbar click on “Image” > “Information”.

4) This brings up the “Image property options”.
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5) Check the compression of the image, if it says “JPEG” the image is a baseline JPEG, however
if it says “JPEG, progressive” then you must convert the image using software such as
Adobe Photoshop.

5.8 My media files will not update

If you are have problems updating your display follow these steps to ensure it is not a technical
issue.
1) Ensure that there are no other files or folders stored on the USB drive.
2) Check the USB drive for any additional self installation software, if it has this format the
drive.
3) Make sure the USB drive is firmly inserted into USB slot
4) Before contacting your supplier try another USB drive to be certain this is not the fault.

5.9My media will not loop

If you are having issues with your content not playing over from the start once it has come to an
end, then you will have to do a system reset.
1) To do this press “SETUP” on your remote control.
) Go to “SYSTEM” and press “PLAY”.
) Go to “Restore Default” and press “PLAY”.
) This will clear the unit’s memory but not the time and date details, try your media again
before contacting your supplier.

B W N
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6. Full Range Specifications
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